
WELCOME TO T-SHIRT MAKER!

T-shirt Maker lets you create custom T-shirts without leaving your computer.    Click "How It Works" 
below for an overview of the process.    Information about how to use T-shirt Maker is available by 
clicking "User Manual."

How It Works

User Manual

If you like T-shirt Maker, you'll love Gift Maker.    Click "About Gift Maker" to find out why one major 
reviewer called Gift Maker "...the absolutely greatest thing I've put on my computer in a long 
time..."

About Gift Maker

Gift Maker Order Form

Send T-shirt Maker To a Friend --- FREE with your purchase of Gift Maker!

Although T-shirt Maker is free, it is NOT in the public domain, and there are restrictions on how you may 
use it.    Click T-shirt Maker Software License Agreement for more information.



USER MANUAL

Creating a T-shirt Design

Placing a T-shirt Order

Customizing T-shirt Maker

Using Your Own Fonts, Graphics, and Photos

Menu Commands

Keyboard Commands

Technical Support



CREATING A T-SHIRT DESIGN

To create a T-shirt design with T-shirt Maker, do the following:

1. Start T-shirt Maker.

2. Select the Make It button.

3. Select the type of T-shirt you want to create.

See Selecting a T-shirt Type.

4. Optionally, select a design template. Or, select "Make Your Own Design" to make a design from 
scratch.

See Selecting a Design Template.

5. Use T-shirt Maker's wide range of features to customize the design.

See Design Window Basics.



SELECTING A T-SHIRT TYPE

Use the Select A T-shirt window to select the type of T-shirt you want to personalize.

To select a T-shirt type, click it in the list of T-shirts and select Continue.

Power tips:

o To go fast:    Double-click the type of T-shirt you want.

NOTE:    You select T-shirt options such as fabric, color, and size when you place your order.



SELECTING A DESIGN TEMPLATE

Use the Select A Design window to preview and select a design template from T-shirt Maker's built-in 
library of over 50 design templates.

IMPORTANT NOTE:    You modify design templates LATER in the Design window, which appears after 
you select the Continue button in the Select A Design window.

EVEN MORE IMPORTANT NOTE:    You don't have to use a design template. Select "Make Your Own 
Design" in the Design Templates list, then select Continue. This will let you start a design from scratch.

Previewing The Design Templates:

1. Optionally, click on a category in the Categories list. T-shirt Maker groups design templates into 
categories so that you can quickly narrow your search for a suitable design.

2. Click in the Design Templates list. Press the Up and Down arrows to view the designs, one at a 
time.

Selecting A Design Template:

1. Select the design template you want to use.

Note:    Select Make Your Own Design to create a design from scratch.

2. Select the Continue button.

Power tips:

o To get a close-in view:    Select the Zoom check box.

o To see the front or back only:    Select the Front or Back check box. These check boxes are 
available only when you are viewing a two-sided design.

o To quickly select a design template and continue:    Double-click the design template you want 
when it appears in the Design Templates list.



DESIGN WINDOW BASICS

The Design window is where you create and modify your T-shirt designs.

WHAT YOU SEE IN THE DESIGN WINDOW:

The Menu Bar, located across the top of the Design window. The Menu Bar is chock full of commands 
that let you add and fine-tune design elements to your heart's content.

The Tool Bar, located immediately below the Menu Bar:

Click the Zoom button to zoom in on any part of the design.

Click the Front/Back buttons to switch between the front and back of a T-shirt.

Click the Go Back button to return to the Select A Design window.

Click the Order It! button to fill out and send the electronic order form.

The Control Panel, located down the left side of the Design window:

Click the Colors button to view the Color Toolbox.

Click the Fonts button to view the Fonts Toolbox.

Click the Shapes button to view the Shapes Toolbox.

Click the Text Effects button to view the Text Effects Toolbox.

The Drawing Area, located below the Tool Bar, where you create or edit your design.



ADDING OBJECTS

To add an object (text, graphic, etc.) to your design, select the type of object you want from the Add 
menu. You must be in the Design window in order to access the Add menu. T-shirt Maker places the 
newly added object in the middle of the image area (the area inside the dotted lines on your T-shirt). You
can then drag it anywhere you like with your mouse.

For more information, see:

Add Menu

Moving Objects



SELECTING OBJECTS

You must first select objects in order to move, delete, or change them.

Selecting A Single Object:

1. Position the mouse pointer over the object you want to move.

2. Click the mouse button.

Selecting Multiple Objects:

Before trying the following steps, try to visualize an imaginary rectangle that completely encompasses 
the objects you want to select. In the following steps, you will draw that rectangle...

1. Position the mouse pointer above and to the left of the top leftmost object you want to select. Be 
careful not to click on an object!

2. Press and hold the mouse button.

3. Drag the mouse until the mouse pointer is below and to the right of the bottom rightmost object you 
want to select.

4. Release the mouse button. T-shirt Maker will select all the objects lying within the rectangular area 
you drew.

Selecting all The Objects In Your Design:

1. Choose Select All from the Edit menu.

Selecting Randomly Located Objects:

1. Press and hold the shift key on your keyboard.

2. Click each object you want to select.

Power tip:    You can deselect objects without de-selecting others. Press and hold the shift key on your 
keyboard while you click the objects you want to deselect.



EDITING TEXT

Editing text in your design:

1. Double-click on the text.

T-shirt Maker will display the Add Text window.

2. Make your edits.

3. Click the OK button.



MOVING OBJECTS

You can move objects with the mouse or with the keyboard.

Moving Objects With Your Mouse:

1. Position the mouse pointer over the object you want to move.

2. Press and hold the mouse button.

3. Drag the mouse until the object is in the correct position.

4. Release the mouse button.

Power tip:    You can move an object to the left or right (or above or below) the window, even when 
zoomed. Drag the object past the window in the direction you want to move. T-shirt Maker will 
automatically scroll the window. When the object is in the correct location, release the mouse button.

Moving Objects With Your Keyboard:

1. Select the object you want to move.

2. Press the arrow keys on your keyboard.

With each key press, T-shirt Maker will move the object a little bit in the direction of the arrow.



SIZING OBJECTS

There are two ways to change the size of an object:    sizing and scaling.

Sizing An Object:

1. Select the object you want to size.

T-shirt Maker will show four little squares -- handles -- at the four corners of the selection rectangle.

2. Position the mouse pointer over the upper left handle.

T-shirt Maker will display the sizing pointer.

3. Press and hold the mouse button while you drag the mouse.

4. Release the mouse button when the object is the desired size.

Scaling An Object:

1. Select the object you want to scale.

T-shirt Maker will show four little squares -- handles -- at the four corners of the selection rectangle.

2. Position the mouse pointer over the bottom right handle.

T-shirt Maker will display the scaling pointer.

3. Press and hold the mouse button while you drag the mouse.

4. Release the mouse button when the object is the desired size.

Hint:    Sizing lets you create interesting distortions. Scaling is preferable when you want an object to 
look the same at any size.



ZOOMING

Use the Zoom button to magnify any area of your design. The zoomed view gives you the most detailed 
preview of how your design will look when reproduced on the selected T-shirt. The Zoom button is visible
in the Tool Bar, immediately below the Menu Bar, in the Design window.

Zooming An Area Of Your Design:

1. Click the Zoom button.

2. Follow the instructions that appear on the screen.

3. When you are finished, click the Zoom button again to "un-zoom."

When you zoom into an area of your design, T-shirt Maker displays scroll bars so that you can move 
around within the design.

Power tips:

o To move up or down quickly when zoomed:    Click immediately above or below the scroll box in 
the vertical scroll bar.

o To move left or right quickly when zoomed:    Click immediately to the left or right of the scroll 
box in the horizontal scroll bar.

o To scroll the window without using the scroll bar:    Press and hold the mouse button, then drag 
the mouse pointer past the edge of the Drawing Area. T-shirt Maker will automatically scroll the 
window in the direction of the pointer.

o To move an object to the left or right of (or above or below) the zoomed area:    Position your 
mouse pointer over the object you want to move, press and hold the mouse button, and drag the 
object past the window in the direction you want to move. T-shirt Maker will automatically scroll the 
window.



BEYOND THE BASICS

Rotating Objects

Tilting Objects

Layering Objects

Color Concerns

Printing



ROTATING OBJECTS

You can rotate objects with the mouse or the keyboard.

Rotating An Object With The Mouse:

1. Click the object you want to rotate.

T-shirt Maker will show four little squares -- handles -- at the four corners of the selection rectangle.

2. Position the mouse pointer over the top right handle.

T-shirt Maker will display the rotation pointer.

3. Press and hold the mouse button while you drag the mouse in a clockwise or counter-clockwise 
direction.

4. Release the mouse button when the object is the desired angle.

Power Tip:    The selected object rotates from its center; once you've held down the mouse button, you 
can drag the pointer anywhere in the window. For greater control over the degree of rotation, drag the 
pointer as far from the center of the object as possible, then move it in a clockwise or counter-clockwise 
location.



TILTING OBJECTS

1. Select the object you want to tilt.

T-shirt Maker will show four little squares -- handles -- at the four corners of the selection rectangle.

2. Position the mouse pointer over the lower left handle.

T-shirt Maker will display the tilting pointer.

3. Press and hold the mouse button while you drag the mouse to the left or right direction.

4. Release the mouse button when the object is the desired angle.

MASTER OF THE UNIVERSE POWER T(R)IP:    You can simultaneously rotate, tile, size, and scale 
multiple objects by selecting the objects, then dragging the appropriate handle of any selected object.



LAYERING OBJECTS

Every object in your design occupies a unique location, or layer, in front or behind other objects in the 
design. You can see this if you drag one object partly over another. The object that is in front of the other
will be completely visible, while the other will be partly covered by the other object. If you were to move 
all the objects into the middle of the design area, they would be stacked on top of each other, much like 
the cards in a deck of cards.

You can change the location of an object relative to the other objects by selecting it and choosing any of 
the ordering commands from the Add menu:

o Bring to Front places the selected object on top of all other objects, but Bring Forward will cause 
it to swap places with the next highest object.

o Send to Back will put the selected object beneath the other objects, and Send Backward will cause
it to swap places with the next object underneath it.



COLOR CONCERNS

What You See Is NOT EXACTLY What You Get:

In general, the colors you see on your computer monitor will approximate, but not precisely match, those
that appear on the manufactured T-shirt. This is due to differences between the emitted light of your 
monitor and the types of inks and dyes used in the production process. If you have a color printer, you 
are already aware of this limitation. In addition, the same color on one monitor will appear different on 
another monitor. You should not use T-shirt Maker for the manufacture of items that require faithful color 
reproduction against a color standard such as PMS.

Choosing Colored T-Shirts

Some T-shirt Maker T-shirts (e.g., 50/50 T-shirts) are available in multiple colors. Your computer's screen
does not accurately reflect the effect of reproducing your design on non-white T-shirts. In general, the 
design will take on the overall cast of the T-shirt color. For example, a design on a rose colored T-shirt 
will have a rose colored cast. Some people find this objectionable, while others do not. In general, for 
the most faithful reproduction of photos, we recommend you select white T-shirts only.



PRINTING

You can print a proof of the currently visible design on a properly installed desktop printer.

1. If necessary, open the design you want to print.

You can open an existing design by choosing Open from the File menu

2. Choose Print from the File menu.

3. Optionally, select the Setup button to confirm settings for the currently selected printer.

4. Select OK.

Note:    The T-shirt Maker factory will not reproduce objects or portions of objects that lie outside the T-
shirts image area.



THE TOOLBOXES

T-shirt Maker's toolboxes are represented by buttons in the Control Panel, located down the left side of 
the Design window.

The Colors Toolbox

The Fonts Toolbox

The Shapes Toolbox

The Text Effects Toolbox



THE COLORS TOOLBOX

Use the Colors Toolbox to change the color of text and graphics in your design.

Changing The Color Of Objects:

1. Select the object whose color you want to change.

2. If necessary, click the Colors button in the top left area of the Design window to display the Colors 
Toolbox.

Shortcut:    You can also press Alt+V+C.

3. Optionally, click on the pull-down menu immediately above the color squares to see what elements 
of the selected object you can color separately.

For example, you can change the text outline color independently of its main color, background, 
and, where appropriate, drop shadows.

In all cases, you can also change the color of the design background. In some cases, you can 
change the color of the currently selected T-shirt.

4. Click the element whose color you want to change.

5. Click the desired color square.

Note:    You cannot change the color of imported bitmap graphics. In general, bitmap graphics consist of 
thousands of differently colored bits. However, you can change the color of bitmaps in applications 
designed for that purpose, then import them into T-shirt Maker by choosing Import from the File menu.

Restoring The Original Color Of Objects:

1. Select the object.

2. Click the top left color square in the Colors Toolbox.

Changing The Color Of Graphics:    Most graphics consist of multicolored elements, and were not 
designed to be colored in programs like T-shirt Maker. T-shirt Maker takes a crack at it anyway, just for 
the heck of it. Sometimes the results are reasonable; other times -- woah!    If you don't like the results, 
click the top left color square (the one with the diagonal lines through it) to restore it to its original color.



THE FONTS TOOLBOX

Use the Fonts Toolbox to change the typeface and style of text in your design.

Changing The Typeface Of Text:

1. Select the text whose typeface you want to change.

2. If necessary, click the Fonts button in the top left area of the Design window to display the Fonts 
Toolbox.

Shortcut:    You can also press Alt+V+F.

T-shirt Maker displays fonts that are on both your computer and the computers at the T-Shirt Maker 
factory. Unfortunately, T-Shirt Maker cannot use any font on your computer, because the same font 
may not be on the computer at the factory. It is not legal for you to send your font files to the factory.
However, the T-shirt Maker factory computers have over 200 of the most popular TrueType fonts 
available.

3. Click the font you want.

Power Tip:    You can click in the fonts list, then press the Up and Down arrows to see how the font will 
appear in a sequence of fonts.

Changing The Style Of Text:

1. Select the text whose style you want to change.

2. If necessary, click the Fonts button in the top left area of the Design window to display the Fonts 
Toolbox.

The style check boxes appear below the fonts list.

3. Click the check box(es) for the style(s) you want.

Try selecting different combinations of styles to see the effect. Click the Plain check box to remove 
all other selected styles with a single click.

Power Tip:    You can change the typeface or style of multiple text objects simultaneously by first 
selecting all the objects, then selecting the typeface or style.



THE SHAPES TOOLBOX

Use the Shapes Toolbox to change the of objects in your design.

Changing The Shapes Of Objects:

1. Select the object whose shape you want to change.

2. If necessary, click the Shapes button in the top left area of the Design window to display the Shapes
Toolbox.

Shortcut:    You can also press Alt+V+S.

T-shirt Maker displays its list of shapes.

3. Click the shape you want.

Power Tip:    You can click in the shapes list, then press the Up and Down arrows to see how the object 
will appear in a sequence of shapes.



THE TEXT EFFECTS TOOLBOX

Use the Text Effects Toolbox to change a variety of text effects of text in your design.

Creating Text Effects:

1. Select the text to which you want to apply text effects.

2. If necessary, click the Text Effects button in the top left area of the Design window to display the 
Text Effects Toolbox.

Shortcut:    You can also press Alt+V+T.

T-shirt Maker displays the Text Effects Toolbox. The "A" list contains shadows of various depths, 
layers and angles that you can apply to the selected text.

3. Click the shadow style, patterns, and outline thicknesses you want.

You can select any combination of text effects.

Note:    You can change the color of the text outline with the Colors toolbox.



PLACING A T-SHIRT ORDER: OVERVIEW

To convert your T-shirt design into an real T-shirt, you fill out an electronic order form and send your 
design file to the T-shirt Maker factory. The factory will produce your order, and ship it to any address in 
the United States or Canada.

Click below for more information:

How To Place an Order

How Long Does It Take?

How Much Does It Cost?

All About Your T-shirts



HOW TO PLACE AN ORDER

Starting The Order Process

Billing Information

Shipping Information

Selecting T-shirts

Gift Card Enclosures

Order Summary Info

Rights, Rules and Regulations

Select Method for Ordering

Modem Setup

Modem Order Failure



STARTING THE ORDER PROCESS

You can start a T-shirt order from any of the following places in T-shirt Maker:

o From the Welcome to T-shirt Maker! window by clicking on the Order It! button

o From the Design window, by clicking on the Order It! button, located in the Tool Bar

o From the Design window, by choosing Order It! from the Order menu.

All three go to the same place -- the Ordering T-shirts window. This is the first in a sequence of windows 
in which you enter all the information necessary for the T-shirt Maker factory to process your order. Just 
follow the instructions on the screen.



BILLING INFORMATION

Enter your complete name, address, and preferred payment method in the Billing Info window. T-shirt 
Maker saves the billing information on your computer's hard disk so that you don't have to enter it a 
second time.

CHILD-PROOFING THE ORDER FORM:    When we first showed T-shirt Maker to the general public, 
some parents worried that their children might run up huge credit card bills. Not to worry. You can tell T-
shirt Maker to "forget" your credit card number, so that every time someone places an order, they have 
to re-enter the credit number. If your children don't know your credit card number, then they won't be 
able to use it. And if they do, it's too late anyway.

To child-proof your T-shirt Maker order form, do the following:

1. If you have started the ordering process, select Cancel.

2. If T-shirt Maker asks if you want to save your order, make the appropriate selection.

3. Choose Preferences from the Edit menu.

4. Select "Save credit card number for next order" check box.

If this check box    is checked, then click it to turn off saving. If it is not checked, then don't touch it -- 
your order form is already child-proof.



SHIPPING INFORMATION

You can ship T-shirts to more than one shipping address. T-shirt Maker offers your billing address as the 
first Shipping address. If that is not correct, simply type over the values in the Shipping Information 
boxes.

You can choose from a drop-down list of shipping methods, accessed by clicking on the down arrow 
next to Ship By. The faster delivery choices (2-3 Day and Overnight) have higher shipping costs.    
FedEx shipping costs are shown in the Order Summary, which appears towards the end fo the order 
process.

For information on delivery times, select the Delivery Info button.



SELECTING T-SHIRTS

Use the T-shirts window to select the T-shirts you want to send to the address shown at the top of the 
window.

Click once on your selection in each of the drop down menus in the upper half of the window. The 
menus drop down automatically to help you move through them quickly. A menu will stay gray if it is not 
applicable to the selected T-shirt type. For example, there are no color choices for 100% cotton T-shirts 
because currently T-shirt Maker doesn't support colored cotton shirts.

If you get stuck:    Click the Undo button to start from the beginning. Click once (do not double-click) in 
each drop down menu on the item of your choice.

Finding Your Design File:    T-shirt Maker automatically saves your design files in a subdirectory called 
"Designs," located within the T-shirt Maker directory. If you have saved your design file in a different 
directory, you can find it by clicking the Find File button.

Changing Your Mind:    You can change your mind about a T-shirt even after you have accepted it. 
Click the item in the scrolling list, then click on the drop down menu whose selection you want to 
change.

Ordering Multiple Items:    If you want to order more than one type of T-shirt, or different T-shirts with 
different designs, click the Add Item button, then repeat the process you went through for the first item. 
You can order up to 99 different items for a single address in this manner. Once you are satisfied with 
the accuracy of your order, click Continue.



GIFT CARD ENCLOSURES

Use the Gift Cards window to enter the text for a gift card to go along with your T-shirts. Your text will be 
hand-written on cards at the factory.

Gift    card options:

o You can have a single card for an entire order of T-shirts going to a single location.

o You can have a separate card for each T-shirt in the order.    This is handy when sending separate 
T-shirts to multiple individuals at a single location.

To indicate which option you want, simply answer the questions in the Gift Cards window.

Entering your message:    Type the text for the gift card in the text box, which appears after you have 
selected a gift card option. Use the Enter key to move the text insertion point to the next line.    You can 
use all the standard editing keys.

If you have two or more items, type in text for the highlighted item and then click on the next item to get 
the empty text box again for the next card.



ORDER SUMMARY INFO

Use the Order Summary window to verify the details of your order. This window will reveal all of the work
you've just done to the shipping address, shipping method, T-shirts and gift card message for each 
order. 

The Order Summary also shows prices, discounts, shipping, tax and your order total.

Changing Your Order:

If you need to change any part of your order, double-click on the appropriate line and you will return to 
the window in which the information was entered. Make the change you want, then click on Continue to 
return to the Order Summary window.

You can also select Go Back until you get to the window containing the information you want to change, 
then select Continue until you return to the Order Summary.



RIGHTS, RULES AND REGULATIONS

Review the text in this window carefully. By checking the Yes box and continuing, you are legally bound 
by the terms and conditions presented in the text.



SELECT METHOD FOR ORDERING

If you are paying by check, or if you are including a photograph you must send your order by mail. 
Select the "By Mail" option and follow the instructions presented to you. See Sending Your T-shirt Order 
By Mail for more information.

You can send your order directly to the factory via modem. Simply select the "Direct to Factory" option 
and click on Continue to go on. See Sending Your T-shirt Order via Modem for more information.

If you are a member of CompuServe, select the "By On-Line Service" option. There you will be able to 
create a file that can be mailed directly to the T-shirt Maker factory's mailbox. This option is attractive 
because most CompuServe phone numbers are local calls, potentially saving you money. See the 
Sending your T-shirt order via CompuServe for more details.



SENDING YOUR T-SHIRT ORDER BY MAIL

As the Select Disk window advises, you must have a blank formatted floppy disk in the selected drive in 
order to copy your file. T-shirt Maker will check your disk in preparation for writing the design file to it. If 
the disk isn't blank, you'll see a warning to insert a blank or to select OK to delete any existing files and 
write your T-shirt design to disk.

IF YOU DON'T HAVE A BLANK, FORMATTED DISK HANDY:  You can temporarily leave T-shirt Maker
to format a disk, and then return to T-shirt Maker and pick up where you left off:

1. Press Alt+Tab until you see the Windows Program Manager.

2. Open the File Manager.

3. Insert a blank disk in your floppy disk drive.

4. Choose Format Disk from the Disk menu, make your selections, and select OK.

5. Press Alt+Tab as many times as necessary to return to T-shirt Maker and continue.

When T-shirt Maker finishes copying the order file to the floppy, the Mail T-shirt Order window presents 
the final instructions and the factory mailing address.

The factory mailing address:

T-shirt Maker
c/o Artistic Greetings
P.O. Box 996
Elmira, NY    14902-9872



SENDING YOUR T-SHIRT ORDER VIA COMPUSERVE

T-shirt Maker users can get a free one-month membership to the CompuServe electronic bulletin board 
service, where you can send your T-shirt Maker designs, and have access to the vast resources of the 
CompuServe service.

T-shirt Maker users can receive their free start-up disk by calling 1-800-524-3388 and asking for 
Operator 300.

This Offer Includes:

o the free communications information manager software

o one free month of basic CompuServe service, and

o $75.00 credit towards extended and premium services

Once you are set up with CompuServe, you can use the By On-line Service option in the Send Method 
window. When you hit Continue, you'll go into the On-line Service window. Just highlight the 
CompuServe choice and click on Continue. Follow the instructions on the screen.

Post your files to the T-shirt Maker's CompuServe address (74774,1533). Your design files will receive 
prompt attention, whether sent direct to the factory or via modem.

PLEASE DO NOT ATTACH A MESSAGE TO YOUR FILE. There is no guarantee your message will be 
read or responded to. If you have a question about your order, please call the T-Shirt Maker factory at 1-
800-443-8657.



SENDING YOUR T-SHIRT ORDER VIA MODEM

Click on Continue and you will see a window telling you your file is being compressed for transmission. If
this is your first time ordering a product by modem, select the Setup Modem option from the middle of 
the window and make certain that your modem is set-up properly.

Follow the instructions at the top of the Transmit Order File window to be sure that your modem is turned
on and connected and select Continue.

The modem will dial and connect automatically. You will get an estimate of how long your transfer will 
take. You can decide now if you want to continue or cancel. If conditions are good, your actual time may 
take less time than the estimate. At this point the Transmitting picture will be highlighted and you will 
soon be shown a progress bar that indicates how much of the file has been transmitted.

After the transmission you may receive a news flash, or an opportunity to update one or more of your T-
shirt Maker files. If you accept, a file will be downloaded to your T-shirt Maker directory. You will see the 
T-Shirt Maker factory's number on your phone bill as a standard long distance call, so you may want to 
transmit your order when rates are low.



MODEM SETUP

The Modem Setup window is where you set up T-shirt Maker for your particular modem type and 
location.

In the first element of the Modem Setup you specify the type of modem that you have. If your modem is 
there, click on its name. If it is not, choose the modem most like yours. There are some generic choices 
for 9600 and 14,400 bps that should serve for most unlisted modems, and the Hayes choices cover a 
broad range of compatible modems.

Underneath the modem list is the Modem Com Port box, with a drop down menu for the communications
ports detected by the program for your computer. Select the appropriate port. In the Maximum Baud 
Rate box, use the drop-down menu to choose the rate appropriate for your modem. You may notice that 
there is no choice for 14,400 bps modems. For these you can select any speed up to 57,600 bps. The 
US Robotics 14.4 Sportster modem does not connect at speeds above 19,200 bps. If you are having 
trouble connecting with your 14.400 bps modem, try the 19,200 bps setting.

At the bottom of the window is a check marked box that defaults to the area code of the factory. Leave 
that alone unless you are sending your files from within that area code.

In the box below, put in any necessary dialing prefixes: "1" if it is necessary for you to dial a 1 before a 
long distance call, "9" if you are dialing through an office phone line that requires it for an outside line. 
You can also enter calling card access codes if that is how you want your call to be billed.

Click on OK once you are satisfied with your modem settings. This will return you to the order window.



MODEM ORDER FAILURE

If you are experiencing difficulty sending your file, click on the Modem Setup button to verify your 
modem option. Try a couple of different modem type selections. You may find that the Generic settings 
will work where the specific type doesn't.

Be sure that all of your cables for your modem and phone lines are properly connected.

If you are using a US Robotics 14.4 Sportster Fax/Modem, select the 19,200 speed to avoid difficulties 
connecting with the T-shirt Maker factory.

If you continue to have failures sending your order via modem, you    can try the CompuServe option, or 
send    in your file via Mail.



HOW LONG DOES IT TAKE?

The T-shirt Maker factory is committed to processing your order within 3 days of receipt at our factory.    
Your order will then ship in accordance with the shipping method you choose on the T-shirt Maker order 
form.

If an item is out of stock, the factory will inform you in writing of the expected delay.    Also, your credit 
card will be charged only at the time of shipment.    If the event of a partial shipment, the shipping 
charges for the entire order will be included in the first billing.

Regular Delivery Please allow from 2 to 10 business days for regular delivery.    The number of 
days depends on your distance from the T-shirt Maker factory in New York.

Regular Delivery orders usually ship via United Parcel Service, except for 
shipments to P.O. boxes, which must ship via U.S. Parcel Post.

FedEx 2-day Please allow 2 business days for Federal Express 2-day delivery to any location 
within the United States.    NOTE: You cannot use Federal Express to ship to 
P.O. boxes.

FedEx Overnight Please allow 1 business day for Federal Express overnight service to any 
location within the United States.    NOTE:    You cannot use Federal Express to 
ship to P.O. boxes.



HOW MUCH DOES IT COST?

Prices are guaranteed through December 31, 1995, and thereafter are subject to change.    After that 
date, you can call 1-800-443-8657 to request an updated price list.

Item Size Color Price
Sleep Tee One size for 

all
White 18.95

T-shirt, youth S (6-8), 
M (10-12), 
L (14-16)

White 14.95

T-shirt, 50/50 M-L-XL-XXL White 14.95
T-shirt, 100% 
cotton

M-L-XL-XXL White, Ash,
Rose

16.95

T-shirt, long sleeve M-L-XL-XXL White 19.95

Additional Charges:

Add $3.50 per photo that you send to the factory.    Note:    This does not include photos you scan 
yourself and import into the T-shirt design.    However, for best results, we recommend you send us your 
photo.    Our trained operators can get the best result scanning your photo on one of our high-end 
scanners.    Your photo will be returned to you.

There is an additional charge of $6.00 for imprinting on both sides of an item.

Volume discounts:

Price discounts for volume orders on items with the same design are as follows:

Quantity Discount
10-24 5%
25-50 10%
50+ Call 1-800-443-8657



CUSTOMIZING T-SHIRT MAKER

T-shirt Maker offers a variety of ways to customize it for your particular style and needs:

Customizing the Upcoming Dates Calendar

Changing Preferences



UPCOMING DATES

Use the Upcoming Dates window to keep track of important days through the year. Upcoming Dates 
shows a running calendar of yearly events for which you might want to create T-shirts for events or 
special occasions. You can add your own special dates to this list, such as birthdays, anniversaries, 
family reunions, and so on.

T-shirt Maker displays Upcoming Dates automatically every time you start the program, unless you turn 
this feature off. (See Hiding Upcoming Dates below). You can view Upcoming Dates at any other time 
by selecting Upcoming Dates from the Edit menu.

Click the underlined text below for more information:

Adding A Date

Changing A Date

Deleting A Date

Hiding Upcoming Dates



ADDING A DATE

In the Upcoming Dates window:

1. Type a description of the event into the box labeled "New Event."

2. Select the month and day of the event.

3. Select the "Add" button.

Note:  You only have to enter your special dates once!    T-shirt Maker will remember them from year to 
year, and display them automatically one year in advance.



CHANGING A DATE

In the Upcoming Dates window:

1. Click the date you want to change.

2. Edit the name, month, or day.

3. Select the Add button.



DELETING A DATE

In the Upcoming Dates window:

1. Select the date you want to delete.

2. Select the Delete button.

Power Tip:    Delete all the dates you don't observe. This will make it easier for you to see -- and 
remember -- the dates that really matter to you.



HIDING UPCOMING DATES

T-shirt Maker automatically displays Upcoming Dates every time the program starts. This will help you 
spot and prepare T-shirts for important events well in advance. If you don't want Upcoming Dates to 
appear automatically, do the following:

a. Deselect the "Show upcoming dates when program starts" check box in the Upcoming Dates 
window, OR

b. Select Preferences from the Edit menu, then deselect the "Show upcoming dates when program 
starts" check box.

Both steps produce the same result.



CHANGING PREFERENCES

The Preferences windows lets you change any of the following options:

o Whether to show the Upcoming Dates window when T-shirt Maker starts. The Upcoming Dates 
window can help remind you of special occasions far enough in advance to create a T-shirt for the 
occasion.

o Whether to have T-shirt Maker display helpful prompts in the Design window when designing your 
T-shirt. These are on by default, but you can turn them off permanently by selecting this option.

o Whether to have T-shirt Maker warn you if design elements fall outside the legal image area. If you 
turn this option off, keep in mind that portions of objects that fall outside the image area will not be 
reproduced on the T-shirt.

o Whether to save your credit card number on disk, so that you don't have to re-enter it each time you
place an order for T-shirts. (Note:    By turning this option off, you can ensure that your children don't
use T-shirt Maker to place unsupervised orders, provided, of course, that they don't know your 
credit card number.)

To change any of these options, choose Preferences from the Edit menu, and select or de-select the 
appropriate option.



MENU COMMANDS

File Menu

Edit Menu

Add Menu

View Menu

Order Menu

Help Menu



FILE MENU

New Opens the Select A T-shirt window, from which you can choose a T-shirt type to begin
the T-shirt-design process.

Open Displays the Open window, from which you can retrieve one of your saved T-shirt 
designs from your computers hard disk and display it in the T-shirt Design window. 
You can then change the design, if desired.

Close Closes the currently open T-shirt design file without exiting from T-shirt Maker.

Save Saves the currently open T-shirt-design file to disk.

When you save a T-shirt design for the first time, T-shirt Maker displays the Save As 
window to let you save the new file with the name of your choosing.

Save As Displays the Save As window so that you can save the current T-shirt design with the 
file name of your choosing.

Revert to Saved Throws away all the changes youve made since you last saved your T-shirt design. 
You will be given a warning that any current design changes wont be saved.

Import Image... Displays the Import Image window, from which you can chose a file to import into 
your T-shirt design.

To import a graphic, select the type file you want to import from the "List Files of 
Type" pull-down, then locate the drive and directory containing the file you want to 
import. Then, double-click the file.

Print Setup... Displays the Print Setup window, from which you can select the printer on which to 
print a proof of your T-shirt design.

Print Displays the Print window, from which you can print a proof of your T-shirt design.

Exit Closes the T-shirt design and exits from T-shirt Maker.



EDIT MENU

Undo Undoes, or reverses, your last action. To undo an action, you must choose Undo 
before you do anything else.

Cut Removes whatever is selected in the T-shirt design and places it in a temporary 
storage area called the Clipboard. You can then paste objects on the Clipboard back 
into your original document or into other T-shirt Maker documents. (See your 
Windows manual if you want additional information on the use of the Clipboard.)

Copy Creates a copy of whatever is selected and places it on the Clipboard, from which 
they can be pasted into your original document or into other T-shirt Maker 
documents.

Paste Pastes the contents of the Clipboard to your design file. Freshly copied elements, 
when pasted, will be placed on top of and slightly offset from the original.

Delete Removes selected objects from your design. You can retrieve them if you use the 
Undo command before executing any other commands. Deleted objects are not 
placed on the Clipboard. If you change your mind about deleting an object, choose 
Undo from the Edit menu immediately.

Duplicate Copies a selected object and places it on top of and slightly offset from the original.

Select All Selects all of the elements in your design so that you can manipulate them as a 
group.

Upcoming Dates... Lets you personalize the calendar of national holiday events with your personal 
occasions of consequence. Preferences... Displays the Preferences 
window, from which you can change any of the program options. When checked, 
the Show Upcoming Dates When Program Starts will display the Upcoming 
Dates window, explained above. The Show Design Help Prompts choice, when 
check-marked, will display the help prompts in the Design window that advise 
you on design editing. 

The Verify Design Elements Are Within Drawing Area option, when on, will inform
you when objects in your design are out of the printable area, and thus wont be 
displayed upon your completed T-shirt. The Save Credit Card Number For Next 
Order is a child-proofing option: when on, your credit card number will appear 
automatically in the Billing Information ordering window every time the window is 
opened, after you've entered it for your first order. If you click off the check-mark, 
no one can misuse your credit card for T-shirt Maker orders.



ADD MENU

Add Text... Displays the Add Text window, at which you can enter text to be added to your T-
shirt design.

Note:    You can edit existing text in the T-shirt design by double-clicking it.

This windows text functions are like a standard word-wrapping text editor: you 
can use the Delete and Backspace keys, double-click to select a word, and hit 
the Return or Enter key to begin another line. Once you click on OK, the text will 
be displayed as a selected object in your design in the default typeface and style: 
Arial, Plain. The text will be centered within the text box. You can then modify it 
with whatever effects suit your fancy.

Add Graphic... Displays the Add Graphic window, from which you can select one of T-shirt 
Makers built-in graphics, and add it to your T-shirt design.

You can also add outside graphics using the Import button, which will display the 
Import Image window. Imported graphics may not reproduce as well on your T-
shirts as the T-shirt Maker graphics.

Add Photo... Displays the Add Photo window, at which you can chose the shape for a photo to 
be added to your T-shirt design. For more information, see Using Your Own 
Photos.

Add Border... Displays the Add Border window, from which you can choose a border to be 
placed around (a) a selected object in your design, or (b) the entire image area.

If you choose Around Object with more than one object selected, every object will
have its own border.

Add Backdrop... Displays the Add Backdrop window, from which you can choose a backdrop, or 
background, for your design.

Once the backdrop is placed in your design, it can be scaled, skewed, rotated 
and sized, but since it is sized by default to fill the active area of your drawing, 
remember that any edits that move parts of the backdrop out of that active area 
will make those outside elements not print.

Align Text Opens a submenu of commands (Left, Center, Right, Justify) that control the 
placement of selected text objects within the text frame (Center is the default). 
Justify will stretch the text to both edges of the frame, putting equal space 
between letters to achieve the headline look.

Bring Forward Moves a selected object or multiple objects one level forward in the drawing 
layer. The visual presumption is that the objects, both text and graphics, are 
stacked like cards in a deck, and Bring Forward and the other commands below 
allow you to shuffle those objects on top of and below one another.



Bring to Front Moves a selected object or multiple objects to the front of the drawing layer.

Send Backward Moves a selected object or multiple objects one level back in the drawing layer.

Send to Back Moves a selected object or multiple objects to the back of the drawing layer.

Flip Horizontal Flips the selected object on its horizontal axis. Thus if you flipped the word Yo, it 
would read oY, but the individual letters would be backwards as well.

Flip Vertical Flips the selected object on its vertical axis. Yo would be upside down.

Rotate Opens a submenu of commands (45, 90, 180, None) that rotate a selected object
or multiple objects specific increments. None will return the object to its original 
horizontal plane. You can rotate objects at any other desired angle by using the 
rotation handle on a selected objects frame.

Lock Prevents a selected object or multiple objects from being moved, rotated, tilted, 
sized or scaled. Locked objects can still be edited (text) and colored.

Unlock Reverses the Lock command.



VIEW MENU

The View menu includes the commands to look at and edit your design from its various aspects and at 
different magnifications. The selection of text and graphics effects toolboxes are also accessible from 
the View menu.

Front of [Design] Displays the front side of your T-shirt design in the Design window.

Back of [Design] Displays the back side of your T-shirt design in the Design window, if a back side 
is available.

Colors Displays the Colors toolbox palette, check-marking the current choice for a 
selected object. See the Creating a T-shirt design Help topic for information on 
the use of the Colors, Fonts, Shapes and Text Effects toolboxes.

Fonts Displays the Fonts toolbox menu, including font styles highlighting the current 
choices for a selected object.

Shapes Displays a selection of shapes that can be applied to the currently selected text 
and/or graphic objects.

Text Effects Displays a selection of effects that can be applied to text objects.

Zoom... In the Design window, this command displays the zoom cursor used to select an 
area of your image for close-up magnification. With your left mouse button held 
down, drag this cursor around the area you want magnified and then release the 
button to see a detailed view of your design.

Un-Zoom Returns the zoomed image to normal magnification.



ORDER MENU

The Order menu provides the means to process and manage your orders. See Placing a T-shirt Order 
for how to information.

Order It!... Brings up the Ordering T-shirts window, from which you can begin the sequence 
of steps (and windows) to smoothly process the completion of your T-shirt order.

Old Orders... Brings up the Old Orders window, where you can view past orders including all of
the shipping and fiscal particulars. The most recent orders are at the top of the 
screen; you can scroll to review older orders.

Price List... Displays a list of all current prices for each T-shirt type, including charges for 
miscellaneous/associated procedures. The list has an expiration date, and can 
be updated.



HELP MENU

Utilizing the Windows Help system, the Help menu gives you access to context-sensitive help for all 
aspects of the T-shirt Maker software.

Index... Displays the T-shirt Maker Help Index, which holds a list of topics that can be 
clicked to view their respective information on T-shirt Maker techniques. You are 
currently reading the Summary of Menu Commands topic.

Using Help... Provides you with instruction on how to use the Windows Help system.

Prompts Toggles on and off the help bubbles within any new Design window that give you 
hints on how to modify your design templates. A check mark next to the 
command indicates that Prompts are active.

About T-shirt Maker... Displays version and registration information for T-shirt Maker, as well as the 
program credits.



KEYBOARD COMMANDS

File Menu 
Command

Keyboard 
Equivalent

Function

New Ctrl + N Opens Select A T-
shirt window

Open Ctrl + O Opens window to 
search for T-shirt files

Close Ctrl + W Closes open T-shirt 
Maker file

Save Ctrl + S Saves new file or file 
changes

Print Ctrl + P Prints T-shirt Maker 
file

Exit Alt + F4 Exits T-shirt Maker 
program

Edit Menu 
Command

Keyboard 
Equivalent

Function

Undo Ctrl + Z Undoes last 
command

Cut Ctrl + X Cuts selected object 
to Clipboard

Copy Ctrl + C Copies selected 
object

Paste Ctrl + V Pastes Clipboard 
object to file

Delete Del Deletes object from 
file

Duplicate Ctrl + D Copies object and 
places it in design

Select All Ctrl + A Selects all objects in 
Design window



Add Menu 
Command

Keyboard 
Equivalent

Function

Lock Ctrl + L Locks objects in 
Design window

Unlock Ctrl + U Unlocks locked 
objects

Help Menu 
Command

Keyboard 
Equivalent

Function

Index F1 Opens T-shirt Maker 
Help index



ALL ABOUT YOUR T-SHIRTS

The Factory

The T-shirts

Satisfaction Guaranteed

Customer Service



THE FACTORY

Your T-shirt Maker T-shirts are produced in Elmira, New York by Artistic Greetings, a $85 million 
company with nearly 70 years experience in manufacturing high-quality, custom merchandise.    Artistic 
operators transfer your design onto premium quality T-shirts using state-of-the-art digital imaging 
equipment.    The production process yields bright, vibrant, and durable images.

Your T-shirt order will be shipped in quality packaging with a personally signed quality inspection 
certificate and detailed care instructions.    The merchandise is fully guaranteed.    See Satisfaction 
Guaranteed.



THE T-SHIRTS

The T-shirt Maker factory uses only premium brand T-shirts.    For example, at present, our T-shirts are 
Fruit of the Loom.    The actual brands may change over time, but we are committed to using T-shirts that
look and feel great.    And if for any reason you are not completely satisfied, you may return them for 
your money back.    See Satisfaction Guaranteed.

All T-shirts are carefully folded, wrapped, and packaged to protect them from damage during shipping.    
When you open your order, you'll find an autographed quality inspection certificate, along with detailed 
care instructions.



SATISFACTION GUARANTEED

If for any reason you are not completely satisfied, you may return your merchandise within 30 days of 
receipt for prompt replacement, refund, or credit (except shipping & handling).    Please send returns 
prepaid.    No C.O.D.'s.



CUSTOMER SERVICE

We want you to be delighted with your T-shirt Maker creation.    Please call our customer service 
representatives to address any questions or concerns.    For questions about your order, contact Artistic 
Greetings, Inc. at 1-800-443-8657.



TECHNICAL SUPPORT

Getting Help:

Since T-shirt Maker is free, we are unable to provide free or regularly scheduled support.    However, 
technical support is available on a paid, call-back basis at the rate of $7.50 per five (5) minutes, in five 
minute increments, payable by credit card only.

Our Technical Support voice mail-box phone number is: 415-324-4229

If you call, please be sure to leave the following information:

1) Your name

2) Your telephone number

3) Your fax number (** IMPORTANT **)

4) A brief description of the problem, including the steps that must be taken to reproduce it.

We will either (a) fax instructions to you if we understand your problem, or (b) call you back, usually 
within 2 business days.

There is no charge if we can respond via fax.    There is no charge if the problem is identified as a "bug" 
in T-shirt Maker.    Austin-James, Inc. reserves the right to make final determination whether a problem is
a "bug" or not.

Suggestions:

We welcome your suggestions.    There is never any charge for suggestions.    However, we prefer to 
receive you suggestions in writing at any of the following addresses:

Via Mail: Austin-James, Inc.
405 El Camino Real #601
Menlo Park, CA    94025

Via Fax: 415-324-3755

Via E-Mail: Our Internet address is: AJINC@IX.NETCOM.COM.    You can send messages to 
Internet address from almost any on-line service such as CompuServe or America 
Online.



T-SHIRT MAKER SOFTWARE LICENSE AGREEMENT

1. Grant of License

This T-shirt Maker license agreement grants you a non-exclusive right to load and use the T-shirt Maker 
Software Freeware Version 1.0x (the "Software"), subject to the restrictions below.

The Software is "loaded" onto a computer when it is either copied to the permanent memory of the 
computer (for example, the hard disk) or loaded into the temporary memory (RAM), such as when a 
computer runs the software from a network server, or a floppy disk.

2. Copyright

The Software is owned by Austin-James, Inc. and is protected by United States copyright laws and 
international treaty provisions. You must treat the software like any other copyrighted material ( for 
example, a book), except that you may make a copy for the purposes of loading it onto the hard disk of 
the computers that are licensed under this agreement.

3. Other Restrictions

You may not transfer your rights under this agreement. You must not rent or lease this software. You 
may not decompile or disassemble the Software. You may not distribute the Software as part of any of 
any other software, or collection of software without the agreement of Austin-James Inc.

4. Distribution

The freeware version of T-shirt Maker may distributed only under the terms and conditions of the 
Distribution License shown in the file VENDOR.TXT.

LIMITED WARRANTY AND DISCLAIMER OF WARRANTY

THIS SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING INSTRUCTIONS FOR 
USE) ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND. FURTHER, AUSTIN-JAMES, 
INC. DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE 
USE, OR THE RESULTS OF USE, OF THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF 
CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK 
AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IF THE 
SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE YOU, AND NOT AUSTIN-JAMES INC. OR 
ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR, OR CORRECTION.

THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, THAT IS MADE BY AUSTIN-JAMES INC., ON THIS AUSTIN-JAMES INC. 
PRODUCT. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY AUSTIN-JAMES INC., 
ITS DEALERS,DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A WARRANTY OR IN 
ANY WAY INCREASE THE SCOPE OF THIS WARRANTY AND YOU MAY NOT RELY ON ANY SUCH 
INFORMATION OR ADVICE. YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO 
STATE.

NEITHER AUSTIN-JAMES INC. NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE 
CREATION, PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY 
DIRECT, INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR 



LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, 
ANDTHE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE SUCH PRODUCT EVEN IF 
AUSTIN-JAMES INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.



ABOUT GIFT MAKER

If you like T-shirt Maker, you'll love Gift Maker because it has everything in T-shirt Maker plus much 
more!

With Gift Maker, you can create custom mugs, baseball caps, mousepads, coasters, pennants, totes, 
and more -- 30 different kinds of items in all (including T-shirts!)    All items are FULLY GUARANTEED.

For more information, click on a topic:

What You Can Create With Gift Maker

What the Critics Say About Gift Maker

Why You Should Upgrade To Gift Maker

How To Order



WHAT YOU CAN CREATE WITH GIFT MAKER

Your unique, custom designs can be produced in brilliant colors on any of the following items:

Aprons

Attache cases

Baseball caps

Calendars (fabric)

Clocks

Coasters

Director's chairs

Duffel bags

Jackets (sports)

Jackets (wind)

Laundry bags

Mouse pads

Mugs

Neckties

Ornaments

Oven mitts

Pennants

Polo shirts

Sleep tees

Steins

Sweat pants

Sweat shirts

Sweat shirts, hooded

T-shirts, short sleeve

T-shirts, long sleeve

Tank tops

Teddy bears

Tiles

Tote bags

Visors

All items are fully guaranteed.



WHAT THE CRITICS SAY

"Easily the most innovative departure in software this holiday season..."
Washington Post, 12/94

"One of the best gifts for anyone whos high on high tech.... Very easy to use."
CBS This Morning, 12/5/94

"Whether youre crafting surprises for 1 or 1 million.... For people who enjoy expressing their creativity, 
this is the best invention since the glue stick."
Computer Life, 12/94

"Number 1 on my list is Gift Maker, the absolutely greatest thing Ive put on my computer in a long 
time...."
Chicago Tribune, 12/94

"New software -- really new software -- is always a turn on and Maxis Gift Maker clearly qualifies.... A 
savior for the holidays.... For the retail challenged among us, holidays, birthdays, and anniversaries may
never hold the same terror again."
PC World, 12/94

"Gift Maker is easy to use and the ordering process is painless."
Houston Chronicle, 12/94

"Gift Maker adds a new dimension to ... gift giving."
Los Angeles Times, 11/9/94

"...easy, even for the nonartist...a clever, well designed piece of software that lots of folks will find 
useful."
The Wall Street Journal, 10/27/94

"Gift Maker ... is the most comprehensive program for creating personalized items."
N.Y. Post, 11/10/94

"This boutique-in-a-box puts your favorite designs on more than 40 gift items."
PC Magazine, 12/6/94

"Goes way beyond typical personalized gift catalogs.... Its easy to use."
Baltimore Morning Sun, 11/14/94

"Gift Maker is easy enough for children to use, and theyll love the creative aspect the computer 
provides."
Family PC, 11/94



WHY YOU SHOULD UPGRADE TO GIFT MAKER

1.    Lower prices: Gift Maker T-shirts cost $1 to $2 less, and steeper volume discounts are 
available.

2.    More choices: With Gift Maker, you can customize 30 different items.    See "What You Can 
Create With Gift Maker.'

3.    More art: Gift Maker contains 30 built-in fonts, 500 graphics, and over 400 design 
templates.

4.    Fully supported: Gift Maker is constantly being enhanced and improved. As a registered Gift 
Maker user, you will receive notification of updates and add-ons.

5.    Free support: Gift Maker customers receive 90 days of free technical support.



GIFT MAKER ORDER FORM

===============================================================
=

INSTRUCTIONS

To order BY PHONE: Call 800-281-1045, 24 hours, 7 days a week

To order BY FAX: 1. Choose "Print Topic" from the File menu to print this form.
2. Fill out the form and fax it to:    415-324-3755

To order BY MAIL: 1. Choose "Print Topic" from the File menu. Austin-James, Inc.
2. Fill out the form and mail it with payment to: 405 El Camino Real, Suite 601

Menlo Park, CA    94025
===============================================================
=

SHIP TO

Name________________________________ Company________________________________

Street________________________________________________________________________

City_____________________________ State_______ ZIP_____________ Country__________

Phone_____________________ Fax______________________ EMail____________________

QTY DESCRIPTION UNIT PRICE AMOUNT

_____ Gift Maker*                [        ] 3.5"      [        ] CDROM               $29.95                  
____________

_____ Gift Maker Site License**                                      Call       800-281-1045    
____________

_____ Complimentary T-Shirt Maker***                                            FREE!              ___FREE!___

* Individual units are sold with a Single User License, which 
permits use of Gift Maker on a single computer, or on two 
computers used exclusively by the same individual. Includes 5 
complimentary copies of T-shirt Maker.

** A Site License permits use of Gift Maker on a several 
computers at a single site or on the same network. It includes 
only one copy of the program and documentation.

** Click on the word FREE! above for information.

SUBTOTAL ($US) ____________

SHIPPING & HANDLING*** ____________
(US=$5 each, Other=$10 each)

SALES TAX ____________
(CA residents add 7%)

AMOUNT DUE ($US) ____________

===============================================================
=

PAYMENT METHOD

___Visa/MasterCard ___Check or Money Order ____Purchase Order (call)

Number:___ ___ ___ ___        ___ ___ ___ ___        ___ ___ ___ ___        ___ ___ ___ ___

Name:      ___ ___ ___ ___ ___ ___ ___ ___ ___ ___ ___ ___ ___ ___ ___ ___ ___ ___ ___



Expires: ___ ___ / ___ ___ Signature:______________________________________



SEND T-SHIRT MAKER TO A FRIEND!

===============================================================
=

COMPLIMENTARY COPIES OF T-SHIRT MAKER

Do you like T-shirt Maker?    Tell your friends!    Better yet, send them a copy 
so that they can try it out for themselves!

With your purchase of Gift Maker, Austin-James will send up to FIVE FREE 
COPIES of T-shirt Maker to your friends in the United States or Canada at 
no expense to you.

Just choose "Print Topic" from the File menu to print this form, fill it out, and 
send it along with your Gift Maker Order Form. We'll mail each friend a 3.5" 
disk, with your compliments printed clearly on the front of the envelope, as 
shown in the picture to the left.

Name________________________________ Company________________________________

Street________________________________________________________________________

City_____________________________ State_______ ZIP_____________ Country__________

Compliments of: _______________________________________________________________

Name________________________________ Company________________________________

Street________________________________________________________________________

City_____________________________ State_______ ZIP_____________ Country__________

Compliments of: _______________________________________________________________

Name________________________________ Company________________________________

Street________________________________________________________________________

City_____________________________ State_______ ZIP_____________ Country__________

Compliments of: _______________________________________________________________

Name________________________________ Company________________________________

Street________________________________________________________________________

City_____________________________ State_______ ZIP_____________ Country__________

Compliments of: _______________________________________________________________

Name________________________________ Company________________________________

Street________________________________________________________________________

City_____________________________ State_______ ZIP_____________ Country__________

Compliments of: _______________________________________________________________






